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L121 User's Guide
Welcome to the L121 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.
Printer Parts Locations
The Power Off and Sleep Timers

Printer Parts Locations
See these sections to identify the parts on your printer.
Control Panel Buttons and Lights
Printer Parts - Top
Printer Parts - Inside
Printer Parts - Back
Parent topic: Product Basics

Control Panel Buttons and Lights
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1 power button
2 power light
3 Error light
4 cancel button

Parent topic: Printer Parts Locations

Printer Parts - Top

1 Rear paper feed
2 Paper support
3 Ink tanks
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4 Control panel
5 Edge guide

Parent topic: Printer Parts Locations

Printer Parts - Inside

1 Front cover
2 Print head in home position

Parent topic: Printer Parts Locations
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Printer Parts - Back

1 AC inlet
2 USB port

Parent topic: Printer Parts Locations

The Power Off and Sleep Timers
The product enters sleep mode or turns off automatically if it is not used for a period of time. You can
adjust the time period before power management begins, but increasing the time reduces the product's
energy efficiency.
Changing the Power Off and Sleep Timer Settings - Windows
Changing the Power Off and Sleep Timer Settings - Mac
Parent topic: Product Basics

Changing the Power Off and Sleep Timer Settings - Windows
You can use the printer software to change the time period before the printer enters sleep mode or turns
off automatically.
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1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Printer Settings and click the
Maintenance tab.

2. Click the Printer and Option Information button.
You see this window:

3. Select the time period you want as the Power Off Timer setting.
4. Click Send.
5. Select the time period you want as the Sleep Timer setting.
6. Click Send.
7. Click OK to close the open program windows.
Parent topic: The Power Off and Sleep Timers
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Changing the Power Off and Sleep Timer Settings - Mac
You can use the printer software to change the time period before the printer enters sleep mode or turns
off automatically.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select Printer Settings.
You see this screen:

3. Select the time period you want as the Power Off Timer setting.
4. Select the time period you want as the Sleep Timer setting.
5. Click Apply.
6. If you see the confirmation message, click Yes, and close the Printer Settings window.
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Parent topic: The Power Off and Sleep Timers
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper
Paper Loading Capacity

Loading Paper
You can print on plain paper in these sizes: Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7
inches [210 × 297 mm]), and Legal (8.5 × 14 inches [216 × 356 mm]).
1. Pull up the paper support.
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2. Slide the edge guide left.

3. Insert paper, printable side up and short edge first, against the right side. If you are inserting a stack
of paper, fan the sheets first and tap the stack on a flat surface to even the edges.
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4. Slide the edge guide against the paper, but not too tightly.

Note: Leave enough space in front of the product for the paper to be fully ejected.

Note: Return unused paper to the original package as soon as you finish printing. Keep unused
paper and prints away from high temperature, humidity, and direct sunlight.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guide.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
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Paper Loading Capacity
Paper type Load up to this many sheets
Plain paper - Letter (8.5 × 11 inches
[216 × 279 mm]) or A4 (8.3 × 11.7 inches
[210 × 297 mm])

Approx. 50 sheets for one-sided printing *
15 sheets for two-sided printing

Plain paper - Legal (8.5 × 14 inches
[216 × 356 mm])

1 sheet

* Based on paper weight of 20 lb (75 g/m2). Do not load paper above the arrow mark inside the edge
guide.
Parent topic: Loading Paper
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Cancelling Printing Using a Product Button
Related tasks
Checking for Software Updates

Printing with Windows
You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer
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Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a document or photo for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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4. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

5. Select the orientation of your document.
6. Select the Quality setting that matches the print quality you want to use.
7. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

8. To print on both sides of the paper, select the 2-Sided Printing checkbox and select the options you
want.

9. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

10. To print multiple copies and arrange their print order, select the Copies options.
11. To preview your job before printing, select Print Preview.
12. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
13. To reduce noise during printing, turn Quiet Mode on.
Print Quality Options - Windows
Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related tasks
Printing Your Document or Photo - Windows

Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print.
Standard

For everyday text and image printing.
High

For photos and graphics with high print quality.
More Settings

Opens a window that lets you choose among levels of speed and quality.
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Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting the 2-Sided Printing checkbox on the Main tab.

Note: You will need to print one side and flip the paper over manually to print the other side.

Note: This feature is available only when EPSON Status Monitor 3 is enabled. To enable the status
monitor, access the printer driver and click the Maintenance tab followed by the Extended Settings
button. In the Extended Settings window,check the Enable EPSON Status Monitor 3 check box.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network or as a shared printer.

1. Select the 2-Sided Printing checkbox.
2. Click the Settings button.
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You see this window:

3. Select the double-sided printing options you want to use.

Note: The actual binding margin may be different from the specified settings depending on your
application.

4. Click OK to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.

Note: The surface of the paper may smear during double-sided printing. Make sure the ink has dried
before reloading the paper. Only use papers that are suitable for 2-sided printing.

Double-sided Printing Options - Windows
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Parent topic: Printing with Windows
Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
Binding Margin Options

Select options that define a wider margin to allow for binding.
Booklet

Select the Booklet checkbox to print double-sided pages as a booklet.
Parent topic: Selecting Double-sided Printing Settings - Windows

Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.
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1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your

document or photo as the Document Size setting, and the size of your paper as the Output Paper
setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
• Select Custom and click the Advanced button to manually adjust the color correction settings or

turn off color management in your printer software.
• Select Image Options to access additional settings for improving printed images.

3. To add the following features, click the Watermark Features button:
• Watermark: adds a visible watermark to your printout
• Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with Windows
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Custom Color Correction Options - Windows
You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Fix Red-Eye

Reduces or removes red-eye in photos.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
High Speed

Speeds up printing but may reduce print quality.
Mirror Image

Flips the printed image left to right.
Quiet Mode

Lessens noise during printing but may decrease print speed.
Parent topic: Selecting Additional Layout and Print Options - Windows

Header/Footer Settings - Windows
You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.
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Note: These settings are not saved with your document.

You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Collate Number

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

2. Place your cursor over one of the Printing Presets to view its list of settings.



32

3. Click on a preset to change its settings or delete it, or use any of the available options on the screen
to control your printing presets.

4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.

You see the maintenance options:
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4. Click the Extended Settings button.
You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows

Extended Settings - Windows
You can select these settings on the Extended Settings window.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Separator Page

Before each document, prints a separator page containing the title, user, date, and time.
Always Spool RAW Datatype

Increases print speed and may solve other printing problems.
Page Rendering Mode

Increases print speed when printing is extremely slow or the print head stops during printing.
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Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows
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Checking Print Status - Windows
During printing, you can see the progress of your print job by accessing the Windows Desktop and
double-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up
arrow and double-clicking . Click Print Queue.

You can control printing using the options on the screen.
• To cancel printing, right-click on any print job and click Cancel.
• To pause printing, right-click on any print job and click Pause.
• To restart printing, right-click on any paused print job and click Restart.
Parent topic: Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.



37

You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
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You see the printer settings window.
3. Click the Maintenance tab.

You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.
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1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates

Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.



40

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see a window like this:

4. Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

5. Click the Advanced button.
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You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

11. Select the orientation of your document as the Orientation setting.
12. Click OK to save your settings.

You see your application's Print window.
13. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S

Printing on a Mac
You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website or using Epson Software Updater.

Selecting Basic Print Settings - Mac
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Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac
Sizing Printed Images - Mac
Managing Color - Mac
Printing Your Document - Mac
Selecting Printing Preferences - Mac
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the Show Details button to expand the print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.



46

6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Note: Paper sizes may include additional options such as Borderless.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings or Printer Features from the pop-up menu.
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You see these settings:

Note: The available print settings and appearance of the print window may be different than those
covered here, depending on the Mac OS version and the application you are using.

9. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

10. Select the Print Quality setting you want to use.
11. Select the Borderless checkbox if you want to print a borderless photo. If the option is grayed out,

change the Media Type setting to a paper type that supports borderless printing.
12. Select any of the available print options.
Print Quality Options - Mac
Print Options - Mac
Parent topic: Printing on a Mac
Related tasks
Selecting Page Setup Settings - Mac
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Printing Your Document - Mac
Print Quality Options - Mac

You can select any of the available Print Quality options to fine-tune the quality of your print.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Quality

For photos and graphics with good quality and print speed.
High Quality

For photos and graphics with high print quality.
Parent topic: Selecting Basic Print Settings - Mac

Print Options - Mac
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Grayscale

Prints text and graphics in black or shades of gray.
Mirror Image

Lets you flip the printed image horizontally.
Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. You can also select a custom
setting to create a custom paper size.
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2. Select the orientation of your document or photo as shown in the print window.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac

Selecting Print Layout Options - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing on a Mac
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Sizing Printed Images - Mac
You can adjust print order and the size of the image as you print it by selecting Paper Handling from the
pop-up menu on the Print window.

• To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

• To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.
• To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and

select a paper size from the Destination Paper Size pop-up menu.
Parent topic: Printing on a Mac

Managing Color - Mac
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.
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2. Select one of the available options.
3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac
Parent topic: Printing on a Mac

Color Matching and Color Options - Mac
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer driver or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac

Printing Your Document - Mac
Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

Checking Print Status - Mac
Parent topic: Printing on a Mac

Checking Print Status - Mac
During printing, you can view the progress of your print job and control printing.
1. Click the printer icon when it appears in the Dock.

You see the print status window:
2. Select the following options as necessary:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings.

Parent topic: Printing Your Document - Mac
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Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.

You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac
Parent topic: Printing on a Mac

Printing Preferences - Mac
You can select these settings on the Options or Driver tab.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
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Quiet Mode
Lessens noise during printing but may decrease print speed.

High Speed Printing
Speeds up printing but may reduce print quality.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Cancelling Printing Using a Product Button
If you need to cancel printing, press the stop button.
Parent topic: Printing from a Computer
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Refilling Ink
When the ink level is below the lower line on an ink tank, you need to refill it.
Before checking the ink levels or refilling an ink tank as described here, be sure to read the ink safety
precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Ink Safety Precautions
Check Ink Levels
Purchase Epson Ink
Refilling the Ink Tanks

Ink Safety Precautions
Note: Epson strongly recommends the use of genuine ink to ensure optimal print quality and
performance.

Ink Handling Precautions
• Keep ink bottles and the ink tanks out of the reach of children. Do not allow children to drink from or

handle the ink bottles and bottle caps.
• Do not tilt or shake an ink bottle after opening it; otherwise, ink may leak.

Ink Refilling Precautions
• Use ink bottles with the correct part number for this product.
• The use of non-Epson ink may cause damage that is not covered by Epson’s warranty, and under

certain circumstances, may cause erratic product behavior.
• This product requires careful handling of ink. Ink may splatter when the ink tanks are filled or refilled

with ink. If ink gets on your clothes or belongings, it may not come off.
• Do not open the ink bottle package until you are ready to fill an ink tank. Ink bottles are vacuum

packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print
quality may be affected.
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• If the ink level is below the lower line on an ink tank, refill the ink. Continued use of the product when
the ink level is below the lower line on an ink tank could damage the product.

• Visually check the ink levels in the product’s ink tanks to confirm the actual ink levels. Continued use
of the product when the ink is below the lower line on an ink tank could damage the product.

• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for
at least three hours before using it.

• Use the ink bottle before the date printed on the package.
• Store ink bottles in a cool, dark place. Keep them out of direct sunlight.
• Store the ink bottles in the same environment as the product. When storing or transporting an opened

ink bottle, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink
may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright
when tightening the cap, and take measures to prevent ink from leaking when you transport the bottle.

Ink Bottle and Ink Tank Information
• To maintain optimum print head performance, some ink is consumed from all ink tanks during printing

and when performing maintenance operations, such as cleaning the print head.
• Quoted ink yields may vary depending on the images you are printing, the paper type you are using,

how often you print, and environmental conditions such as temperature.
• The ink bottles may contain recycled materials, but this does not affect product function or

performance.
• When printing in monochrome or grayscale, color ink may be used instead of black ink, depending on

the paper type or print quality settings. This is because a mixture of color inks is used to create black.
Parent topic: Refilling Ink

Check Ink Levels
To confirm the actual ink remaining, visually check the ink levels in the product’s ink tanks. Make sure
the ink levels are above the lower lines on the ink tanks.
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Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Disabling Special Offers with Windows
Parent topic: Refilling Ink
Related references
Ink Safety Precautions

Disabling Special Offers with Windows
You can disable special offers messages from Epson using a utility on your Windows computer.

Note: You may see the Epson Special Offers screen every time you print (if your computer is connected
to the Internet). Select Do not display this message again and click Decline to disable online offers.
Promotional offers are not valid in Latin America.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Monitoring Preferences.
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You see this window:

2. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Ink Levels

Purchase Epson Ink
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.

https://latin.epson.com


60

Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not
specified for this printer could cause damage not covered by Epson's warranties.
The ink bottles that are used for initial product setup have a lower yield due to the ink charging process.
This process is carried out the first time you turn on the printer and guarantees better performance.
Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and
temperature. Do not load paper before refilling the ink tanks.
Check the ink level in your product frequently, and refill the ink tanks if necessary.

Ink Bottle Part Numbers
Parent topic: Refilling Ink

Ink Bottle Part Numbers
Use these part numbers when you order or purchase new ink cartridges.

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Black T664120-AL
Cyan T664220-AL
Magenta T664320-AL
Yellow T664420-AL

Parent topic: Purchase Epson Ink

Refilling the Ink Tanks
Make sure you have new ink bottles handy and have read the ink safety precautions before you begin.

Caution: Wear plastic gloves while refilling the ink tanks to avoid staining your hands.

1. Place a sheet of paper under the ink tank area in case of spills.
2. Turn on your product.
3. Make sure the power light is on, but not flashing.
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4. Remove the ink tank’s cap.

Note: Make sure the color of the ink tank matches the ink color you want to refill, and only remove
the cap from that ink tank. Be careful not to spill any ink.
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5. Remove the bottle cap and the top, but do not dispose of either. Remove the seal from the bottle and
replace the top on the bottle.

Note: Make sure the color of the ink bottle matches the ink color you want to refill.

6. Refill the ink tank with the correct color ink up to the upper line on the ink tank.
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7. if any ink remains in the ink bottle after filling the ink tank, place the bottle cap securely on the bottle
and store the ink bottle upright for later use.

8. Place the cap securely on the ink tank.

9. Repeat the previous steps as necessary for each ink color you need to refill.
Parent topic: Refilling Ink
Related concepts
Purchase Epson Ink
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Related references
Ink Safety Precautions
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to flush the ink tubes.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path
Checking the Number of Sheets Fed
Related concepts
Power Ink Flushing

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may
have to refill the ink tank first.

Print Head Nozzle Check
Print Head Cleaning
Power Ink Flushing
Parent topic: Adjusting Print Quality
Related concepts
Print Head Nozzle Check
Related topics
Refilling Ink

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Buttons
Checking the Nozzles Using a Computer Utility
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Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Buttons

You can check the print head nozzles using the buttons on your product.
1. Press the power button to turn the product off.
2. Load a few sheets of plain paper in the product.
3. Hold down the cancel button and press the power button to turn the product on.
4. When the product turns on, release both buttons.

The product prints a nozzle check pattern.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

6. Do one of the following:
• If there are no gaps, the print head is clean and you can continue printing.
• If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
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Related concepts
Print Head Cleaning
Related tasks
Loading Paper

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
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You see a window like this:

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. Do one of the following:
• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
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Related concepts
Print Head Cleaning
Related tasks
Loading Paper

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may
have to refill the ink tank first.

Cleaning the Print Head Using the Product Buttons
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
Related concepts
Print Head Nozzle Check
Related topics
Refilling Ink

Cleaning the Print Head Using the Product Buttons
You can clean the print head using the buttons on your product.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Hold down the cancel button for 3 seconds to start the cleaning cycle.

The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.
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4. Run a nozzle check to confirm that the print head is clean.
Print head is clean

Print head needs cleaning

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then check the print head nozzles and try cleaning the print head again, if necessary.
If quality still does not improve, flush the ink tubes.
Parent topic: Print Head Cleaning
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Related concepts
Print Head Nozzle Check
Power Ink Flushing
Related tasks
Loading Paper

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
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You see a window like this:

5. Click Start to begin the cleaning cycle.
The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then check the print head nozzles and try cleaning the print head again, if necessary.
If quality still does not improve, flush the ink tubes.
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Parent topic: Print Head Cleaning
Related concepts
Print Head Nozzle Check
Power Ink Flushing
Related tasks
Loading Paper

Power Ink Flushing
If you still see white or dark lines or missing colors in your printouts, even after cleaning the print head
several times, you can perform a Power Ink Flushing.

Caution: Power Ink Flushing consumes a lot of ink and should be performed only if necessary. Refill the
ink tanks before performing a Power Ink Flushing.

Caution: Power Ink Flushing affects the service life of the ink pads by causing them to reach their
capacity sooner. Contact Epson to purchase replacement ink pads before they reach the end of their
service life. When the ink pads reach the end of their service life, the product stops printing and you must
contact Epson for support.

Flushing the Ink Using a Computer Utility
Parent topic: Print Head Maintenance
Related concepts
Check Ink Levels
Related references
Where to Get Help
Related topics
Refilling Ink

Flushing the Ink Using a Computer Utility
You can use the Power Ink Flushing utility to flush the ink.
Before you begin, make sure no product lights are indicating errors.
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1. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and
click the Maintenance tab.

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

2. Click the Power Ink Flushing button.
You see a window like this:

3. Follow the on-screen instructions.
4. When you finish the Power Ink Flushing, turn off the product and wait at least 12 hours before

printing.



78

5. Print a document and check the print quality. If the print quality did not improve, contact Epson for
support.

Parent topic: Power Ink Flushing
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Product Light Status
Related topics
Printing from a Computer

Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using a Computer Utility
Parent topic: Adjusting Print Quality
Related concepts
Print Head Cleaning

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows or Mac computer.
1. Load a few sheets of plain paper in the product.
2. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

3. Select Print Head Alignment.
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4. Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

You see a window like this:

5. Check the printed pattern and follow the instructions on the screen to choose the number of the best
printed pattern for each set.

• After choosing a pattern number, click Next.
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• If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

6. When you are done, click Finish.
Parent topic: Print Head Alignment
Related tasks
Loading Paper

Cleaning the Paper Path
If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and
click the Maintenance tab.

• In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

4. Select Paper Guide Cleaning.
5. Follow the on-screen instructions to feed paper through the product.
6. Check the back of the ejected paper to see if it is clean.
7. Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
Related references
Product Light Status
Related tasks
Loading Paper
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Checking the Number of Sheets Fed
You can view an option that displays the number of sheets of paper that have fed through the product.

Note: You can also view the number of sheets of paper fed through the product by printing a nozzle
check.

Checking the Sheet Counter - Windows
Checking the Sheet Counter - Mac
Parent topic: Adjusting Print Quality

Checking the Sheet Counter - Windows
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.
4. Select Printer and Option Information.
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You see this window:

5. After checking the number of sheets fed into the printer, click OK to close the window.

Note: The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

Parent topic: Checking the Number of Sheets Fed

Checking the Sheet Counter - Mac
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.
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1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select Printer and Option Information.
You see this window:

3. After checking the number of sheets fed into the printer, click OK to close the window.
Parent topic: Checking the Number of Sheets Fed
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Cleaning and Transporting the Product
If your product gets dirty or you need to move it some distance, follow the instructions in these sections.
Cleaning the Product
Transporting Your Product

Cleaning the Product
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may
damage it. Do not place anything on top of the cover or use the cover as a writing surface, or it could get
permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

Caution: Be careful not to touch the parts inside the product.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the outer case with a soft, dry cloth. Do not use any liquid or chemical cleansers.
Parent topic: Cleaning and Transporting the Product

Transporting Your Product
If you need to store your product or transport it some distance, prepare it for transportation as described
here.
Caution: During transportation and storage, follow these guidelines:
• When storing or transporting the printer, place the printer in a plastic bag and fold it closed.Avoid tilting

the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not

subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle
is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take
measures to prevent ink from leaking when transporting the ink bottles.
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• Do not put opened ink bottles in the box with the printer.

1. Turn off the product.
2. Open the front cover and check to see if the print head is in the far right position (the home position).

If not, turn on the product, wait for the print head to move to the far right, then turn the product off
again.

3. Disconnect any connected cables.
4. Unplug the power cable.
5. Remove all the paper from the product.



86

6. Close the paper support.

7. Remove the paper support and detach its mount.
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8. Open the front cover and secure the print head to the case with tape.

Caution: Do not touch or place tape on the white flat cable inside the product; otherwise, you may
damage your product.

9. Close the front cover and secure it with tape.
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10. Check to make sure that the ink tank caps are installed securely.

11. Place the printer in a plastic bag and fold it closed. Pack the printer in its box using the protective
materials.

12. Caution:
• Keep the product level during transport. Otherwise, ink may leak.
• Do not put opened ink bottles in the box with the product.

Before using the product, be sure to remove the tape from the print head.
If print quality has declined when you print again, clean and align the print head.
Parent topic: Cleaning and Transporting the Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Light Status
Running a Product Check
Solving Setup Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit latin.epson.com/support and select your product.
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:

• Access the Windows Desktop and right-clicking the icon for your product in the right side of the
Windows taskbar, or clicking the up arrow and right-clicking .

• On the Maintenance tab in the printer settings window
You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

• macOS 10.12.x to 11.x: You can manually update the software by opening the App Store, selecting
Updates, searching for a software update option for Epson Software, and selecting Update.

Parent topic: Solving Problems
Related tasks
Changing Automatic Update Options

https://latin.epson.com/support
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Product Light Status
You can often diagnose problems with your product by checking its lights.

Lights
1 power
2 error

Light status Condition/solution
The power light is on The product is turned on.

The power light is flashing The product is busy. Wait for the power light to stop flashing before
turning off the product.
If you just filled the ink, the power light will flash for approximately 20
minutes. Do not cancel this process.

The power light is flashing
The error light is flashing

Paper may be jammed in the product. Remove any jammed paper, and
press the cancel button to clear the error.
If the lights still flash, there may be a product error. Turn the product off,
check inside for jammed paper or foreign objects, then turn the product
back on. If the error continues, contact Epson for support.
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Light status Condition/solution
The power and error lights
are flashing simultaneously

An ink pad is nearing or at the end of its service life. Contact Epson for
support.

The power light is flashing
The error light is on

No paper is loaded or multiple sheets fed at one time. Remove any
jammed paper, load paper in the product, and press the cancel
button to clear the error.

The power light is off
The error light is on

An error has occurred during firmware updating. Connect your product
using a USB cable and try updating the firmware again. If the error
continues, contact Epson for support.

The power light is on
The error light is on

Initial ink charging may not be complete. Turn off the product and fill the
ink tanks as described on the Start Here sheet.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be
maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your
LCD screen, or lights on the control panel will advise you when these parts need replacing. If this
happens during the standard warranty of the product, the exchange of the product or replacement of the
pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced
by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems
Related references
Paper Jam Problems
Where to Get Help
Related tasks
Loading Paper

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Press the power button to turn the product off.
2. Disconnect any interface cables connected to your product.
3. Load plain paper in the product.
4. Hold down the cancel button and press the power button to turn the product on.



92

5. When the product turns on, release both buttons.
The product begins printing a nozzle check pattern.

6. Do the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this manual or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Uninstall Your Product Software
Print Head Cleaning
Print Head Alignment
Related references
Where to Get Help
Related tasks
Loading Paper

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Noise After Filling the Ink
Software Installation Problems
Product Lights Turn On and then Turn Off
Product Does Not Turn On or Off
Parent topic: Solving Problems
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Noise After Filling the Ink
If you hear noises from your product after filling the ink tanks with ink, check these explanations:
• The first time you fill the tanks with ink, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 20 minutes, turn off your product. Turn it back on and check to see if charging is
still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related references
Where to Get Help
Related topics
Refilling Ink

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

Parent topic: Solving Setup Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements
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Product Lights Turn On and then Turn Off
The product voltage may not match the electrical outlet rating. Unplug it immediately and check the label
on the back of the product for its voltage rating.

Caution: If the voltage rating does not match, do not plug your product back in. Contact Epson for
support.

Parent topic: Solving Setup Problems
Related references
Where to Get Help

Product Does Not Turn On or Off
If you cannot turn the product on or off, try these solutions:
• If you cannot turn on your product, make sure the power cord is securely connected and hold down

the power button a little longer.
• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off

your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed for printing, remove it. Then reload it in the rear paper feed against the right side

and beneath the tab. Slide the edge guide against the edge of the paper, making sure that the paper
stack is not above the arrow mark on the edge guide.

• Place the product on a flat surface.
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• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• If paper jams when you load only one or two sheets, try loading more sheets at a time. Do not load

more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure your paper meets the specifications for your product.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the rear paper feed printable side up.
• Do not load paper with holes punched in it.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems

Paper Jam Problems
If you have problems with paper jams, try these solutions:
1. Cancel the print job from your computer, if necessary.
2. Gently pull out any jammed paper from the rear paper feed.
3. Open the front cover, and remove the jammed paper and any torn pieces.
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Note: Do not touch the parts shown here or you may damage the product. Never touch the buttons on
the control panel while your hand is inside the printer.

4. Press the cancel button to resume printing.
5. Carefully follow all paper loading instructions when you load new paper.
Parent topic: Solving Paper Problems
Related tasks
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper.
Parent topic: Solving Paper Problems
Related tasks
Cancelling Printing Using a Product Button
Loading Paper
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Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.
Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• Make sure the printer status is not offline or pending.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. Print the image at a lower
resolution or if necessary, increase your system's memory.

• In Windows, make sure your product is selected as the default printer and the printer port setting
matches the printer connection port.

• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

• On a Mac, make sure the printer is added to the printer list and the printer is not paused.
Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check
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Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• On a Mac, make sure you download and install the Epson printer driver.
• Make sure Quiet Mode is turned off.
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• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
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Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Selecting Print Layout Options - Mac

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
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Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software, if available.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
• You may need to refill the ink. Visually check the ink levels.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Check Ink Levels
Print Head Nozzle Check
Print Head Cleaning
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Loading Paper
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Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all print jobs from the Windows Spooler:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Open print queue. Right-click the stalled print job, click
Cancel, and click Yes.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select See what's printing, and select your
product name again, if necessary. Right-click the stalled print job, click Cancel, and click Yes.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Open. Right click the stalled print job, click Cancel, and
click Yes.

• If your product is connected to a USB hub, connect it directly to your computer instead.
• If your computer entered sleep mode the last time you printed, the next print job after your computer

exits sleep mode may contain garbled characters. Print your document again.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
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Loading Paper
Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - Mac

Slanted Printout
If your printouts are slanted, try these solutions:
• Make sure the paper is loaded in the correct direction.
• Make sure your paper meets the specifications for your product.
• Do not load more than the recommended number of sheets.
• Make sure the paper type setting matches the type of paper you loaded.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Alignment
Related tasks
Loading Paper
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
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Incorrect Colors
Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head. If print quality does not improve after aligning the print head, disable the

bidirectional (high speed) setting.
• You may need to refill the ink. Visually check the ink levels.
• If you have not used the product for a long time, run the Power Ink Flushing utility.

Note: Flushing the ink tubes replaces all the ink inside the tubes, so flush the ink only if you cannot
improve print quality by other means.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Check Ink Levels
Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
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• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Dry printouts completely before filing or displaying them. When drying printouts, avoid direct sunlight,

do not use a dryer, and do not touch the printed side of the paper.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density
and/or ink drying time settings.

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Clean the paper path.
• If you have not used the product for a long time, run the Power Ink Flushing utility.

Note: Flushing the ink tubes replaces all the ink inside the tubes, so flush the ink only if you cannot
improve print quality by other means.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink levels may be low. Visually check the ink levels.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
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• Clean the paper path.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Check Ink Levels
Related tasks
Cleaning the Paper Path

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• Adjust the print quality in the product software.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
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Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the Grayscale setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors

may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

• Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

• If you have not used the product for a long time, run the Power Ink Flushing utility.

Note: Flushing the ink tubes replaces all the ink inside the tubes, so flush the ink only if you cannot
improve print quality by other means.

Parent topic: Solving Print Quality Problems
Related concepts
Check Ink Levels
Print Head Nozzle Check
Print Head Cleaning
Purchase Epson Ink
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Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac
Managing Color - Mac

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Printing Software - Windows
Uninstalling Product Software - Mac
Parent topic: Solving Problems

Uninstalling Printing Software - Windows
You can uninstall and then re-install your printer software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

• Windows 10: Click and select (Settings) > Apps > Apps & features. Select the program
you want to uninstall and select Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.
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In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

4. Restart your computer, then re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit latin.epson.com/support and select your product.
2. Click Downloads.
3. Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
4. Run the file you downloaded.
5. Double-click the Uninstaller icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
7. Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help
If you need additional help with your Epson product, contact Epson.
Epson provides these technical support services:

https://latin.epson.com/support
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Internet Support
Visit Epson's support website at latin.epson.com/support for solutions to common problems. You can
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your
questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:

Country Telephone
Argentina (54 11) 5167-0300

0800-288-37766
Bolivia* 800-100-116
Brazil State capitals and metropolitan areas: 3004-6627

Other areas: 0800-377-6627 / 0800-EPSONBR
Chile (56 2) 2484-3400
Colombia Bogota: (57 1) 592-2200

Other cities: 018000-915235
Costa Rica 800-377-6627
Dominican Republic* 1-888-760-0068
Ecuador* 1-800-000-044
El Salvador* 800-6570
Guatemala* 1-800-835-0358

https://latin.epson.com/support
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Country Telephone
Mexico Mexico City: (52 55) 1323-2052

Other cities: 01-800-087-1080
Nicaragua* 00-1-800-226-0368
Panama* 00-800-052-1376
Paraguay 009-800-521-0019
Peru Lima: (51 1) 418-0210

Other cities: 0800-10126
Uruguay 00040-5210067
Venezuela (58 212) 240-1111

* Contact your local phone company to call this toll-free number from a mobile phone.
If your country does not appear in the list, contact the sales office in the nearest country. Toll or long
distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.
Parent topic: Solving Problems

https://latin.epson.com
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Technical Specifications
These sections list the technical specifications for your product.
Windows System Requirements
Mac System Requirements
Printing Specifications
Paper Specifications
Printable Area Specifications
Ink Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista

Note: For the latest product software available for your operating system, visit the Epson support site at
latin.epson.com/support, select your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 11.x
• macOS 10.15.x
• macOS 10.14.x

https://latin.epson.com/support
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• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x

Note: For the latest product software available for your operating system, visit the Epson support site at
latin.epson.com/support, select your product, and select Downloads.

Parent topic: Technical Specifications

Printing Specifications
Paper path Rear paper feed, top entry
Sheet feeder capacity Paper stack thickness of up to 0.2 inches (6 mm)

Parent topic: Technical Specifications

Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Size A4 (8.3 × 11.7 inches [210 × 297 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 356 mm])

https://latin.epson.com/support
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Paper types Plain paper

Note: Your product also supports compatible papers distributed by
Epson. See the link at the end of this topic for a list of compatible
Epson papers.

Thickness Plain paper: 0.003 to 0.004 inch (0.08 to 0.11 mm)
Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)

Parent topic: Technical Specifications

Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets - borders

1 Top/bottom/left/right margins: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 0.12 inch (3 mm) minimum
3 Reduced print quality area/bottom: 0.12 inch (3 mm) minimum

Parent topic: Technical Specifications
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Ink Specifications
Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not
specified for this printer could cause damage not covered by Epson's warranties.
The ink bottles that are used for initial product setup have a lower yield due to the ink charging process.
This process is carried out the first time you turn on the printer and guarantees better performance.
Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and
temperature. Do not load paper before refilling the ink tanks.
Check the ink level in your product frequently, and refill the ink tanks if necessary.

Color Cyan, Magenta, Yellow, Black
Temperature Storage: –4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Parent topic: Technical Specifications

Dimension Specifications
Height Stored: 5.1 inches (130 mm)

Printing: 11.2 inches (285 mm)
Width Stored: 18.1 inches (461 mm)

Printing: 18.1 inches (461 mm)
Depth Stored: 8.5 inches (215 mm)

Printing: 11.2 inches (284 mm)
Weight
(without ink cartridges)

5.3 lb (2.4 kg)

Parent topic: Technical Specifications
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Electrical Specifications
Power supply rating 100 to 240 V
Input voltage range 90 to 264 V
Rated frequency range 50/60 Hz
Input frequency range 49.5 to 60.5 Hz
Rated current 0.5 to 0.3 A
Power consumption Printing: 10 W (ISO/IEC24712); approximately

Ready mode: 2 W; approximately
Sleep mode: 0.6 W; approximately
Power off mode: 0.3 W; approximately

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
(without condensation)

Operating: 20 to 80% RH
Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type USB, compatible with the USB 2.0 Specification

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.
Important Safety Instructions
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.
General Printer Safety Instructions
Parent topic: Notices

General Printer Safety Instructions
• Be sure to follow all warnings and instructions marked on the printer.
• Use only the type of power source indicated on the printer's label.
• Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do

not use the cord with any other equipment.
• Place the printer near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that

regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed.
• If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged

into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

• Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

• Leave enough space in front of the printer for the paper to be fully ejected.
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• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place the printer near a radiator or heating vent or in direct sunlight.
• Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or

the base units of cordless telephones.
• When connecting the printer to a computer or other device with a cable, ensure the correct orientation

of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong
orientation may damage both devices connected by the cable.

• Do not touch the flat white cable inside the printer.
• Do not move the print head by hand; this may damage the printer.
• Do not spill liquid on the printer and do not handle the printer with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may

cause fire.
• Except as specifically explained in your documentation, do not attempt to service the printer yourself.
• Unplug the printer and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

• Unplug the power cord from the electrical outlet if you are not going to use the printer for an extended
period.

• When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;
otherwise, ink may leak.

Parent topic: Important Safety Instructions

FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
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interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
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OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at https://www.jamsadr.com/about/ or
by calling +1-949-224-1810 (from outside the U.S.) or 1-800-352-5267 (from within the U.S.), and under
the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and
both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The
arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court

https://www.jamsadr.com/about/
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or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the
interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or
any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the
arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP
Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be
empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator
may award you the same damages as a court could, and may award declaratory or injunctive relief only
in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted
by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of
litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award
is binding and may be entered as a judgment in any court of competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).

http://www.jamsadr.com
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e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™ is a trademark of Seiko Epson Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.
Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.
App Store, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other
countries.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
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certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products
This product enters sleep mode after a period of nonuse. You can adjust the time period before power
management begins, but increasing the time reduces the product's energy efficiency. Energy savings
can be achieved by setting the time to sleep to a shorter interval.
Parent topic: Copyright Notice

Copyright Attribution
© 2021 Epson America, Inc.
07/21
CPD-60508
Parent topic: Copyright Notice
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